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1: Introduction 
 
 
CPU Features 
 
The Pro One Replacement CPU module can be used to replace a missing or 
damaged 8021. It also offers larger sequence memory and non-volatility.  Here 
are the key features: 
 

o Drop-in replacement using standard tools. Plug-n-Play. No soldering 
required. 

o Supports the original functionality including the sequencer and 
arpeggiator. 

o Each sequence can be up to 256 steps (compared to total of 40 steps on 
the original). 

o Sequences are retained in memory even after power-down. The CPU 
module does not use a battery. 

o Power-on settable parameters for clock start mode, arpeggio up/down end 
notes, arpeggio down mode and arpeggio gate time. 

o Sequence Tie mode allows for a variety of note lengths. 
 

 
 
CPU+MIDI Features 
 
Using the MTG MIDI circuit, or one of your own, adds the following features: 
 

o Firmware update (“re-flashing”) over MIDI (using MIDIOX or similar). 
o Settable MIDI channel. 
o Monophonic MIDI output of arpeggiator and sequencer data. 
o Polyphonic MIDI output of keyboard data. 
o Arpeggiator and sequencer sync-able to MIDI Sync in (settable clock rate). 
o Load/Save sequence data over MIDI. 
o Optional MIDI Thru. 
o Optional MIDI activity LEDs. 
 

 
 
For the latest news, please see the firmware Release Notes on the website 
www.musictechnologiesgroup.com . 
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Precautions 
 

 
 
High Voltage Safety Warning 
 
Turn the Pro One power switch OFF and disconnect the AC power cable before 
opening the Pro One.     
 
ESD Precautions and Proper Handling Procedures 
 
You should observe standard static-safe handling behavior when working with 
sensitive electronic equipment such as synthesizers: 
 

o Avoid carpets in cool, dry areas. Leave the CPU module in its anti-static 
packaging until it is ready to be installed. 

o Dissipate static electricity before handling any system components by 
touching a grounded metal object. 

o If possible, use anti-static devices, such as wrist straps and floor mats. 
o Always hold the CPU module by its edges. Avoid touching the contacts. 
o Take care when connecting or disconnecting cables. A damaged cable 

can cause a short in the electrical circuit. Note the polarity and position for 
later re-installation. 

o Prevent damage to the connectors by aligning connector pins before you 
connect the cable. Misaligned connector pins can cause damage to 
system components at power-on. 

o When disconnecting a cable, always pull on the cable connector or strain-
relief loop, not on the cable itself. 

 
 
Tools Required (CPU only) 
 

o Standard flat-head screwdriver. 
o Plastic ruler or straight edge for checking the module height in the socket. 
o Hex nut driver – in the unlikely event you need to adjust the front panel 

sheet metal alignment (I’m not sure how consistent they were at 
Sequential Circuits Inc). 

 
 
Additional Tools Required for MIDI 
 

o Soldering iron, solder and hook-up wire. 
o Tools and hardware necessary for mounting the MIDI jacks (depends on 

chassis location) and printed circuit board. 
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Condition of Pro One 
 
While the Pro One replacement CPU will replace the functionality of a damaged 
or missing CPU, it will not correct other problems your vintage synthesizer may 
have. It is recommended that the synth be in otherwise good condition before 
beginning the installation. For instance, the keyboard bushings will need to be 
replaced on units that have never had them replaced before (they dry out over 
time and become very brittle). Keyboard contacts should be attended to as 
required according to the procedure in the owner’s manual.  Finally the two 
sockets at the end of the keyboard flat cable are of poor quality and are also 
prone to oxidation over time. Consider having them replaced. 
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2: Installation 
 
Preparation 
 
Carefully remove all of the knobs on the front panel of the Pro One.  You should 
also locate a small container to place the screws in while you work on the synth. 
 
Open the Pro One 
 
Continue with the following steps, taken from the Pro One Operation Manual: 
 

1. Switch the power off and unplug the power cord. 
2. Remove the wooden side panels (2 screws each side). 
3. Remove three screws along the front edge. 
4. Carefully slide the top panel assembly forward. When the front edge is 

clear of the keys, lift it up just enough to allow clearance for your hand. 
5. Note the position and polarity of the AC power connector. Mark the 

connector or take a photograph of it so that you can refer to it later. 
6. Disconnect the AC power connector running from back panel to the 

underside of the printed circuit board (PCB), at right. 
7. Note the position and polarity of the keyboard cable where it attaches to 

the PCB. Either mark the connector or take a photograph of it that you can 
refer to during reassembly. Disconnect the keyboard cable from the PCB. 

8. Do the same for the bender wheel/mod wheel cable. 
 
Remove the Panel PCB 
 
The number of screws used to attach the front panel PCB to the front panel 
varies by production year.  Remove all screws carefully and take care not to 
stress the front panel PCB.   
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Set the panel PCB down on a static safe surface that provides uniform support 
for the PCB.  Do not allow the PCB to flex unnecessarily. 
 
 
 
MIDI Board Installation (Optional) 
 
Please read through this section at least once and PLAN your wiring before 
beginning.  The schematic of the MTG Pro One MIDI board is shown below.  
The LEDs and MIDI Thru connector are not required. 
 

 
This is one of many circuits that would do the job of converting the CPU’s 3v TTL 
signals into the standard MIDI current loop.   
 
See also: http://www.midi.org/techspecs/electrispec.php 
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Mount the MIDI Connectors 
 
Although the MIDI board supports PCB mount 5-pin DIN connectors, most 
people prefer the chassis mount connectors: 
 

  
Chassis mount PCB mount 

 
 
 
Remove the 37-key keybed assembly if 
required.   
 
To mount the connectors in the metal 
chassis you will need to drill/punch holes 
for the connectors. Use the guide on the 
right for making the holes.  A Greenlee 
punch can be used to make nice holes with 
a minimum of fuss. 
 

16.5 mm is approx 5/8” 
3.2mm is approx 4/32” 

 
Make sure any metal residue is removed 
before reinstalling any electronics. 
 
 
 
 
Mount the PCB 
 
The PCB has 4 holes that can be used to fasten it to the chassis bottom or panel 
side. Ideally you should mount the PCB as far away from the sound generation 
electronics as feasible. In lieu of nuts and bolts you may use double-sided foamy 
tape or Velcro for installations that will not be subject to road trips. 
 
Once the PCB and MIDI jacks are mounted, it is a simple matter to connect a few 
wires to the CPU module and jacks. 
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Jack Wiring 
 
If you are using chassis mount connectors then you will need to run connections 
from the PCB to the panel jacks.   Use the diagram below to hook-up the wires. 

1

2

3

4
51

2

3

4
5

MIDI IN
MIDI OUT
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CPU Module Wiring 
 
Determine a path for the wiring from the jack PCB to the CPU module. If you run 
your wiring on top of the Pro One main board, then follow the signal path 
Sequential used for the expansion port.  This keeps the MIDI signals away from 
the audio path. Alternatively run the wiring off the main PCB near the CPU 
module. 
 

 
 
 
Using hookup wire, connect the 
four pins one-to-one between 
the CPU module and the jack 
board. Use the following two 
diagrams as a guide. 
 
The wiring should run under 
the MTG CPU board, not on top 
of it. There is very little vertical 
space above the CPU board for 
anything (about a tenth of an 
inch).  Therefore, when 
connecting the wires from the 
CPU board to the MIDI jack 

+5v
Ground

MIDI IN
MIDI OUT
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board, run the wires beneath the CPU board, to the bottom pads on the CPU 
board and solder on top. Trim the wires neatly on top so that they do not short 
against the front panel when closed. 
 
 

 
 
 
Another Wiring Option 
 
A third wiring option is to run the 
cabling outside of the Pro One to 
an external box or board.  If you 
notice the top edge of the rear 
panel, there is a small gap near 
the modulation section. This was 
originally intended to route 
external cabling for the DIP 
“expansion” socket.  It can easily 
be used to run a flat cable 
outside the Pro One. 
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CPU Module Installation 
 
 
Inspect the area around the existing 8021 CPU (or socket).  To the left and right 
of the CPU are switches. Just “above” it is the Digital-to-Analog converter (DAC) 
chip facing sideways.  The DAC is located at the Pin 1 end of the CPU socket.  
Make sure you know which pin on the CPU socket is Pin 1.  The new module will 
use up almost the entire area bordered by the DAC and the two switches. 
 

 
 
When installed, the module electronics must not sit higher than the height of the 
metal on the two switches because the metal front panel resets approximately on 
the switches.  A small rubber pad has been placed on the new CPU module to 
keep it secure and insulate it from the front panel. 
 
If the original 8021 CPU is present, remove it using a small flat head screwdriver. 
Take care not to bend the leads. Place the 8021 on anti-static foam in case you 
ever want to re-install it or sell it. If the CPU is defective, throw it away.  Really. 
 
Take the Replacement CPU Module out of its anti-static packing and locate pin 1 
on the module.  Pin 1 is located at the top left end of the board where the white 
silkscreen notch is printed. For verification, this end has a single 4-pin header. At 
the other end, near pins 14 and 15, there are two 4-pin headers. 
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Carefully align the 28 pins of the module directly above the vacant CPU socket.  
 
 

 
 
 

Press the module firmly and evenly into place as low as it will go. The two yellow 
resistor packs on each underside should either touch the panel PCB or be very 
near to it.  
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Verify that there are no electrical parts on the CPU module that extend above the 
line where the front panel will rest (on top of the switches). 
 

 
 
 
Carefully reassemble the unit in reverse order.  
 
Make sure the new CPU module fits cleanly in the pre-existing notch that 
Sequential has provided in the plastic front panel.  In the unlikely event that the 
plastic front panel hits the CPU module, you may need to loosen all of the front 
panel hex nuts and adjust the position of the plastic panel versus the metal front 
panel.  
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Test 
 
 
After carefully reassembling the unit, plug the Pro One power in and connect an 
amplifier. Turn the Pro One on. Verify that the module has been installed properly 
and is functioning.  Any problems are likely to be as a result of improper pin 
alignment when installing the module in the CPU socket.  
 
 
Sometimes the original CPU socket is in 
poor condition and a new dual-wiping 
socket is recommended. Make sure that 
any replacement socket is low profile.  
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3: Operation 
 
 
The operation of the Replacement CPU is almost identical to the original. A few 
changes have been made that take advantage of modern microcontroller 
technology (i.e. flash memory).  For the most part, the CPU (original or new) has 
limited control over the Pro One’s sound generation electronics. However some 
enhancements can be made, even without carving up the existing electronics. 
 
 
The features described in this section are configurable in two ways.  
 

o The first way is to use MIDI System Exclusive commands (see the 
appendix for implementation details).  

 
o The second (non-MIDI) way is to use power-on keyboard key 

combinations.  
 

* Because of this, it is important to keep your hands off the keys when * 
* powering the unit up unless you plan on changing the configuration! * 

 
 
 
Power-On Key Map 
 
When reading about the power-on key combinations, refer to the following 
diagram: 
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System-Wide Settings 
 
The following settings affect the Pro One as a whole. 
 
 
MIDI Channel (Param 06) (v0.13+) 
 
 
The MIDI Channel is by default Ch 1 (hex 00).  
 
To change the channel, follow these steps.  Turn the Pro One off.  Hold the G1 
key down along with the MIDI Channel # keys (G#1, A1, A#1 and B1, keys 20 
through 24) then turn the power on.   
 
Refer to the table below: 
 

MIDI 
Channel 

Hex 
 

G1 (20) G#1 (21) A1 (22) A#1 (23) B1 (24) 

1 00 Down Up Up Up Up 
2 01 Down Up Up Up Down 
3 02 Down Up Up Down Up 
4 03 Down Up Up Down Down 
5 04 Down Up Down Up Up 
6 05 Down Up Down Up Down 
7 06 Down Up Down Down Up 
8 07 Down Up Down Down Down 
9 08 Down Down Up Up Up 
10 09 Down Down Up Up Down 
11 0A Down Down Up Down Up 
12 0B Down Down Up Down Down 
13 0C Down Down Down Up Up 
14 0D Down Down Down Up Down 
15 0E Down Down Down Down Up 
16 0F Down Down Down Down Down 

Note: This table was revised in v0.15 
 
 
You can set and read the current MIDI channel using the appropriate System 
Exclusive command.  See Appendix C. 
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Clock Source and Rate 
 
The sequencer and arpeggiator share a common clock. The clock signal can be 
selected from three sources: 
 

o The internal LFO. 
o An external clock-in (voltage pulse such as from a vintage drum machine). 
o MIDI Clock (AKA MIDI Sync). 

 
In addition, when using the internal LFO as the clock source (and to a lesser 
degree the external clock-in) you can also choose when the sound starts (Clock 
Start Mode): 
 

o Sync to User 
o Sync to Clock 

 
When using MIDI clock the clock start mode is always Sync to Clock. 
 
You must also take care when using the RETRIG switch and the REPEAT/EXT 
switch.  If you move these switches in the wrong direction you can alter the 
sound or stop it entirely.  If you are experiencing odd behaviour, try adjusting 
these switches. 
 
 
 
LFO/Ext Clock Start Mode (Param 02) 
 
By default, the Pro One begins a sequence or arpeggio as soon as you set up 
mode (by using the switches and/or playing the keyboard).  The LFO which 
drives the seq/arp starts its cycle fresh at that point.   While this is fine when 
playing solo on the synth, it is not desirable when the syncing the Pro One to 
another device such as a drum machine. In this case the drum machine should 
provide the master clock and the Pro One should follow.  Unfortunately the Pro 
One does not always behave as you would like.  By changing the Clock Start 
Mode you can force the Pro One to wait for the clock before sounding any notes. 
 
NOTE: This setting has no effect if a MIDI Clock Rate value is selected. If a MIDI 
Clock Rate is selected then the sequencer and arpeggiator always wait for the 
first clock after a MIDI start command. 
 
► Sync to User 
 
This is the default behaviour of the Pro One (both stock and the MTG 
Replacement CPU).  To set this mode, power the Pro One off.  Hold the A2 key 
down (key 34). With the key still held down, turn the Pro One on.  
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► Sync to Clock 
 
In this mode the arpeggiator and sequencer wait until the next rising edge of the 
LFO or external clock-in before sounding the first note. This allows for 
dependable and repeatable synchronization to a clock. To set this mode, power 
the Pro One off. Hold the A2 and the A#2 keys down (keys 34 and 35). With the 
keys still held down, turn the Pro One on. 
 
 
 
MIDI Clock Rate (Param 07)  v0.15+ 
 
The Pro One will accept MIDI Clock (F8), MIDI Start (FA) and MIDI Stop (FC) for 
driving the sequencer and the arpeggiator. To use an external MIDI clock, 
choose any setting from the table below except the first one (the first one 
disables the MIDI clock and uses the LFO/External Clock instead).  When a MIDI 
clock value is chosen, the LFO/External Clock will be disabled as a clock source 
for the sequencer and arpeggiator.  Remember to keep the Repeat/Ext switch 
in the lower (NORMAL) position. 
 
The default clock rate is MIDI Clock DISABLED.  To set the MIDI Clock Rate, 
follow these steps.  Turn the Pro One off.  Hold the C1 key down along with the 
MIDI Clock Rate keys (C#1, D1, D#1 and E1, keys 13 through 17), then turn the 
power on.  Refer to the table below and the key map shown previously: 
 
 

Hex Clocks/ 
Quarter 

Note 

Time Value C1 
(13) 

C#1 
(14) 

D1 
(15) 

D#1 
(16) 

E1 
(17) 

00 DISABLED Use LFO clock 
instead 

Down Up Up Up Up 

01 3 1/32 note Down Up Up Up Down
02 4 Dotted 1/32 note Down Up Up Down Up 
03 6 1/16 note Down Up Up Down Down
04 8 Dotted 1/16 note Down Up Down Up Up 
05 12 1/8 note Down Up Down Up Down
06 16 Dotted 1/8 note Down Up Down Down Up 
07 24 Quarter note  Down Up Down Down Down
08 32 Dotted quarter 

note 
Down Down Up Up Up 

09 48 Half note Down Down Up Up Down
0A 64 Dotted half note Down Down Up Down Up 
0B 96 Whole note Down Down Up Down Down
0C 128 Whole note + ¼ 

note 
Down Down Down Up Up 

0D 144 Whole note + ½ Down Down Down Up Down
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note 
0E 168 Whole note + 

dotted ½  
Down Down Down Down Up 

0F 192 Two whole notes Down Down Down Down Down
Note: This table was revised in v0.17 

 
Please note that in this mode you are free to use the onboard LFO for 
modulation effects independent of the MIDI clock. Also, when using MIDI 
clock you need turn the REPEAT/EXT switch off (NORMAL). 
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Sequencer Specific 
 
 
Sequence Memory 
 
The original Pro One sequences were lost on power down. The memory depth 
was only 40 notes for BOTH sequences. Sequence 1 and Sequence 2 had to 
share the 40 notes. 
 
The Replacement CPU maintains the two sequences in separate 256-byte banks 
of flash.  The sequences are retained throughout power cycles. 
 
Sequence data can be saved or loaded using System Exclusive, even while a 
sequence is playing! 
 
 
 
Sequence Tie 
 
The original Pro One sequencer offered two events: note and rest. Since each 
note included retriggering of the envelope (assuming the RETRIG switch was up) 
there was only one note length. 
 
The Replacement CPU records the position of the RETRIG switch along with the 
note value. Thus by lowering the RETRIG switch you can record a note with 
no attack/decay phase. If the first note has been recorded with RETRIG up, 
then another note follows it (same pitch but RETRIG off) then the note sounds 
only as an extension of the previous note (assuming the same key is played). 
Essentially the note length is doubled.  The Roland JX3P uses this technique to 
great effect.  You can also record an entirely new note value with no attack/decay 
phase if you find that to be musically useful. 
 
The factory Pro One has a sequencer gate time of 50%. As of version 0.13, if 
Sequence Tie is enabled, the sequencer gate time is 100%. This improves the 
effect of lengthening notes.  Also, here again you should keep the Repeat/Ext 
switch in the lower (Normal) position. 
 
 
 
Sequence Tie Enable (Param 05) 
 
As described above, the sequencer can now record quarter notes, half notes, 
whole notes, whatever length you want because the sequencer records the 
position of the RETRIG switch with each key. This then makes the RETRIG 
switch nonfunctional during sequence playback.  If you prefer the stock 
behaviour of the original Pro One, you can set that here. 
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► Sequence Tie Enabled 
 
This is the default behaviour of the MTG Replacement CPU but not the stock Pro 
One.  To set this mode, turn the Pro One off. Hold the D2 key down (key 27). 
While holding the key down, turn the Pro One on. 
 
► Sequence Tie Disabled 
 
If you do not wish to use the Sequence Tie, but do want to use the RETRIG 
switch live during sequence playback, follow these steps. This is the default 
behaviour of the SCI stock Pro One.  Power the Po One off.  Hold the D2 and 
D#2 keys down. While holding the keys down, turn the Pro One on. 
 
Note: The Sequential sequence gate time is 50%.  As of v0.13, when Sequence 
Tie is enabled, the sequence gate time is 100%. This improves longer note 
events. 
 
 
 
Sequence Stop Mode (Param 0A) 
 
The stock Pro One stops playing the current sequence as soon as you move the 
SEQ1/SEQ2 switch to the OFF position. If you set the Sequence Stop Mode to 
Sequence-End-Only then after you turn the sequencer off, it will continue to play 
until the end of the sequence data table then stop. This also means that you can 
switch to the other sequence in a live situation and the sequencer will switch over 
smoothly at the end of the current sequence. 
 
► Sequence Stop Mode Normal 
 
This is the default behaviour of the stock Pro one as well as the MTG 
Replacement CPU.  To set this mode, turn the Pro One off. Hold the F2 key 
down (key 18). While holding the key down, turn the Pro One on. 
 
► Sequence Stop on Sequence End Only 
 
To set this mode, turn the Pro One off. Hold the F2 and F#2 keys down (keys 18 
and 19). While holding the keys down, turn the Pro One on. 
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Arpeggiator Specific 
 
 
Arpeggio Gate Time 
 
This is a fairly subtle change from the original Pro One. The LFO clock has a 
50% duty cycle. That means the LFO square wave is high for half the period and 
low for half the period.  The Sequential Pro One leaves the gate on the whole 
time an arpeggio runs (100% gate time).  The attack/decay sound is generated 
by a separate short trigger pulse that occurs on every note.  The Arpeggio Gate 
Time setting allows you to turn the gate time off half-way through the LFO clock 
(50% gate time).  Depending on the patch you are using, it can provide a slightly 
different sound as the patch can enter the release portion of the ADSR cycle. For 
a factory Pro One you would have to lower the sustain and extend the decay 
value for a similar effect. 
 
 

 
 
 
Arpeggio Up/Down Modes 
 
There are two settings that affect the arpeggiator when the Up/Up+Down switch 
is in the lower Up+Down position. The first setting determines whether the end 
notes are heard once (the default), or twice.  The other setting changes the 
Up/Down mode to Down-only. 
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Arpeggio Gate Time (Param 04) 
 
► Arpeggio Gate 100% 
 
This is the default behaviour of the Pro One (both stock and the MTG 
Replacement CPU).  To set this mode, turn the Pro One off.  Hold the F2 key 
down (key 30). With the key still held down, turn the Pro One on. 
 
► Arpeggio Gate 50% 
 
To set this mode, power the Pro One off. Hold the F2 and the F#2 keys down 
(keys 30 and 31). With the keys still held down, turn the Pro One on. 
 
 
 
Arpeggio Up/Down End Notes (Param 03) 
 
When playing an Up/Down Arpeggio the Pro One only sounds the highest and 
lowest notes once.  If you prefer for these end notes to each sound twice, you 
can change the mode using this procedure. 
 
► End Notes Once 
 
This is the default behaviour of the Pro One (both stock and the MTG 
Replacement CPU).  To set this mode, power the Pro One off.  Hold the G2 key 
down (key 32). With the key still held down, turn the Pro One on. 
 
► End Notes Twice 
 
To set this mode, power the Pro One off. Hold the G2 and the G#2 keys down 
(keys 32 and 33). With the keys still held down, turn the Pro One on 
 
 
 
Arpeggio Down Mode (Param 09) 
 
The factory Pro One allows for changing the Up/Down mode to Down by 
modifying a diode on the circuit board. Here you can make the same change but 
much more easily. 
 
► Up/Down Mode 
 
This is the default behaviour of the Pro One (both stock and the MTG 
Replacement CPU).  To set this mode, power the Pro One off.  Hold the C2 key 
down (key 25). With the key still held down, turn the Pro One on. 
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► Down Mode 
 
To set this mode, power the Pro One off.  Hold the C2 and the C#2 keys down 
(keys 25 and 26). With the keys still held down, turn the Pro One on. 
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MIDI Delays 
 
Some older MIDI synths do not react well to MIDI note-off’s followed immediately 
by note-on’s (especially the same note). This is exactly what happens in some 
sequences or arpeggiations (depending on mode). For this reason the MTG Pro 
One CPU will insert a short delay (default is 10ms) when these problematic 
situations occur. This delay is not global, it only appears when it has to.    
 
MIDI Delay (Param 08) 
 
You can shorten or lengthen the MIDI delay using System Exclusive commands.  
Please see Appendix C for more information.   
 
 
 
MTG Factory Defaults 
 
 
If you wish to restore the Pro One to each of the MTG factory default settings, 
 

o Clock Start Mode is Sync to User 
o Arpeggio Up/Down is set to End Notes Once 
o Arpeggio Gate is 100% 
o Sequence Tie is Enabled 
o MIDI Channel is channel 1 
o MIDI Clock is Disabled 
o Arpeggio Up/Down mode is Up/Down 
o Sequence Stop Mode is Normal 
o MIDI Delay time is 10ms 
 

then follow these steps.  Turn the Pro One off. Hold the lowest three notes down 
(C0, C#0 and D0). Turn the Pro One on. 
 
 
 
Bootloader Launch 
 
 
If you have installed the MIDI hardware you can utilize the built-in MIDI 
bootloader to upgrade the firmware.  To launch the bootloader, start with the Pro 
One turned off. Hold the two highest notes down (B2 and C3, keys 36 and 37). 
While holding them down, power on the Pro One.  The bootloader will emit 
several short notes. After that the bootloader remains in control of the synth. 
Follow the instructions in Appendix A.  
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Appendix A: Firmware Upgrade 
 
If you have installed a MIDI interface circuit, you can “reflash” the firmware in the 
Pro One CPU by carefully following the procedure outlined in this section. Obtain 
the latest firmware in .SYX format from the MusicTechnologiesGroup.com 
website. We show the process using MIDIOX, but you should be able to use any 
similar program. 
 
You may lose your sequencer data and user parameters as a result of a firmware 
upgrade.  
 
 
Configure MIDIOX 
 
Set the Sys Ex properties of MIDIOX by clicking: 
 

View->SysEx…   and then   SysEx->Configure  
 

Use the minimum recommended setting shown here: 
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Prepare the Pro One for Download 
 
Hook up the MIDI connections to your computer and to the Pro One. Launch the 
Pro One in bootloader mode by turning off the Pro One, holding the two highest 
keys (B2 and C3) and then while holding those keys down, turning the Pro One 
on.  You should hear several short notes that indicate the MIDI bootloader 
program is in control. 
 
 
Test the Communication 
 
If you send a Universal Device Inquiry system exclusive packet to the Pro One, it 
will respond with the MidiLoader version packet. In MIDIOX, click: 
 

View->SysEx… 
 
Then from the SysEx menu click 
 

Command Window->Load File… 
 
Choose the file Universal Device Inquiry.syx and click open. Click  
 

Command Window->Send/Receive Sysex 
 
The Pro One bootloader will respond with 24 bytes. Click on Done. Next click on 
 

Display Window->Hex View Swap 
 
You may have to enlarge the window a little, but you should see something like: 
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The message must say MidiLoader not ProOne CPU!  If it does, you have not 
launched the bootloader properly. Repeat the above steps carefully. Once you 
verify the MidiLoader message you can proceed with the firmware upgrade. 
 
 
 
 
Firmware Upgrade 
 
Close the SysEx View window and open it again to get an empty window. If you 
are prompted to save anything, click No.  Open the new firmware file by clicking 
 

Command Window->Load File… 
 
Choose the file required for the upgrade (E.g. ProOne_v1_00.syx). You should 
see that a fairly large file is opened. Click on 
 

Command Window->Send/Receive Sysex 
 
The upgrade takes approximately 30 seconds. Do not touch the computer or Pro 
One during this time. At the end of the upgrade the Pro One will reboot. Also the 
MIDIOX screen will show a fairly large number of transactions. You can close 
MIDIOX (don’t save anything) and begin using the updated Pro One. 
 
If the Pro One doesn’t reboot, verify that the Pro One is operational. If not, repeat 
the download. You are advised to perform an MTG Factory Defaults procedure 
on a newly reflashed CPU. 
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Appendix B: MIDI Implementation Summary 
 
The following abbreviated MIDI Implementation charts describe the Pro One 
CPU upgrade MIDI as of this writing for the bootloader and the Pro One synth. 
The bootloader and synthesizer are separate MIDI devices. 
 
 
BootLoader 
 
 

Function Tx Rx Remarks 
System Exclusive o o  
Everything Else x x  
 o : implemented 
 x : not implemented 

 
 
Synthesizer 
 

Function Tx Rx Remarks 
Basic Channel Default 

Changed 
1-16 

x 
1-16 

x 
Set by power-on key 
combinations and SysEx 

Mode Default 
Messages 

x 
x 

[1] 
x 

Last note priority 

Note Number  
True Voice 

36-72 
36-72 

36-86 
36-72 

TBD (limited by DAC) 

Velocity Note On 
Note Off 

x 
x 

x 
x 

 

Pitch Bender  x x TBD (limited by DAC) 
System Exclusive  o o See next chapter. 
Real Time Clock 

Commands 
x 
x 

o 
o 

 
MIDI Sync Start, Stop. 

Everything Else  x x  
 o : implemented 
 x : not implemented 

 [1]: OMNI OFF, MONO 
 
Please note that the synth transmits the arpeggiator and sequencer note data in 
monophonic form. In normal keyboard mode, the synth outputs polyphonic MIDI key 
data. 
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Appendix C: System Exclusive Implementation 
 
 
The Sys Ex engine in the MTG Pro One CPU runs in the background while the 
CPU performs it’s normal duties. Generally this means you can alter parameters 
at the same time the synth is being used to make music.  For instance you can 
download a new sequence while the sequencer is running. 
 
 
Command Types 
 
The table below shows the system exclusive commands supported by the MTG 
Pro One CPU.  A “Get” command implies reading data from the Pro One. A “Set” 
command implies writing data to the Pro One.  The Sent and Recv’d columns 
refer to how many bytes are sent from a PC (or other device) to the Pro One and 
then how many bytes are received in response. 
 

Command 
Type (hex) 

Description Sent 
(# bytes) 

Recv’d 
(# bytes) 

04 Restart 5 7 (ACK) 
05 Get Port  5 6 
21 Get Global Parameter 8 8 
22 Set Global Parameter 8 7 (ACK) 
23 Get Sequence 1 Data 5 Variable 
24 Set Sequence 1 Data Variable 7 (ACK) 
25 Get Sequence 2 Data 5 Variable 
26 Set Sequence 2 Data Variable 7 (ACK) 
-- Universal Device Inquiry 6 24 

 
The Universal Device Inquiry response includes the MTG Pro One CPU firmware 
version number. 
 
 
General Form 
 

(hex) F0 System Exclusive  
 <id> Manufacturer ID. User settable – default is 7D.  
 23 Device ID for the MTG Pro One CPU.  
 <cmd> Command type byte (from table above).  
 (addr) Parameter number byte (if applicable).  
 (data) Data (if any) in nibble pairs.  
 F7 End of System Exclusive  
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Default Responses 
 
A few of the commands to the MTG Pro One CPU return standard “yes” 
(ACKnowledge) or “no” (Not ACKnowledge) response.  Here is the general form 
of those responses. 
 
 
ACK: 
 

(hex) F0 System Exclusive  
 <id> Manufacturer ID. User settable – default is 7D.  
 23 Device ID for the MTG Pro One CPU.  
 <cmd> Echo of whatever the command was.  
 (addr) Echo of whatever the parameter # was.  
 41 ACK – ACKnowledge  

(parameter or value accepted) 
 

 F7 End of System Exclusive 
 
 

 

 
 
NACK: 
 

(hex) F0 System Exclusive  
 <id> Manufacturer ID. User settable – default is 7D.  
 23 Device ID for the MTG Pro One CPU.  
 <cmd> Echo of whatever the command was.  
 (addr) Echo of whatever the parameter # was.  
 4E NACK – Not ACKnowledge  

(parameter or value was out of range, or error) 
 

 F7 End of System Exclusive  
 
 
You should receive an ACKnowledge when setting a parameter.  If you receive a 
NACK instead, then there is something incorrect in your command. 
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Restart Command 
 
 
You can command the MTG Pro One CPU to reboot by issuing this command. If 
you are connected using USB, then you may need to close and reopen the ports 
in your MIDI software.  
 
 
Transmitted: 

(hex) F0 System Exclusive  
 7D Manufacturer ID. User settable – default is 7D.  
 23 Device ID for the MTG Pro One CPU.  
 04 Command type.  
 F7 End of System Exclusive  

 
 
Received:  

ACK packet (then the MTG Pro One CPU reboots) 
 
 
 
 
Get Port Command 
 
You can query the MTG Pro One CPU to determine if it is connected using 5-pin 
DIN MIDI or USB-MIDI  (for now only 5-pin DIN MIDI is supported). 
 
 
Transmitted: 

(hex) F0 System Exclusive  
 7D Manufacturer ID. User settable – default is 7D.  
 23 Device ID for the MTG Pro One CPU.  
 05 Command type.  
 F7 End of System Exclusive  

 
 
Received:  

(hex) F0 System Exclusive  
 7D Manufacturer ID. User settable – default is 7D.  
 4D or 55 4D = ‘M’ = MIDI  

55 = ‘U’ = USB (future feature) 
 

 05 Command type.  
 F7 End of System Exclusive 
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Get/Set Global Parameter List 
 
 
The following table describes the Parameter # and valid data values for the 
Get/Set Global Parameter commands. The Value byte is split into two nibble 
pairs for transmission over MIDI. 
 
 

Parameter # 
(addr in hex) 

Value 
(binary) 

Description 

02 0000 000x Clock Start Mode 
0 = Sync to User* 
1 = Sync to (Ext) Clock 

03 0000 000x Arpeggio Up/Down End Notes 
0 = End notes once* 
1 = End notes twice 

04 0000 000x Arpeggio Gate Time 
0 = 50% 
1 = 100%* 

05 0000 000x Sequence Tie Enable 
0 = Disabled 
1 = Enabled* 

06 0000 nnnn MIDI Channel 
Default is 0000*  
(channel 1, see table) 

07 0000 cccc MIDI Clock Rate  
Default is 0000*  
(disabled, see table) 

08 0ddd dddd MIDI off/on note delay (for old synths) 
Default is 10ms* 
Range is 0ms to 127ms 

09 0000 000m Arpeggio Up/Down Mode 
0 = Up/Down* 
1 = Down 

0A 0000 000m Sequencer Stop Mode 
0 = Normal* 
1 = Stop on sequence end (wrap) only 
* default setting 
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Get Global Parameter Command 
 
By sending a Get Global Parameter Sys Ex command from a host device, the 
user can query the settings in the CPU.  In this implementation one parameter 
byte is read at a time from the table listed above.  Byte addresses outside of the 
parameter list range are ignored.   
 
The command reads a single byte from the CPU, but the data value is received 
as two bytes over MIDI.  The first byte is the most significant nibble of the data. 
The second byte is the least significant nibble of the data. 
 
Request: 
 

(hex) F0 System Exclusive  
 7D Manufacturer ID. User settable – default is 7D.  
 23 Device ID for the MTG Pro One CPU.  
 21 Command (get global parameter).  
 <addr> Parameter # from parameter list table.  
 F7 End of System Exclusive  

 
 
 
Example: Read the active MIDI Channel. 
 
Transmitted: 

(hex) F0 System Exclusive  
 7D Manufacturer ID. User settable – default is 7D.  
 23 Device ID for the MTG Pro One CPU.  
 21 Command type (get global parameter).  
 0C Parameter # from parameter list table.  
 F7 End of System Exclusive  

 
Received: 

(hex) F0 System Exclusive  
 7D Manufacturer ID. User settable – default is 7D.  
 23 Device ID for the MTG Pro One CPU.  
 21 Command type (get global parameter).  
 06 Parameter # from parameter list table.  
 00 Most significant nibble of the value 0F.   
 0F Least significant nibble of the value 0F.  
 F7 End of System Exclusive  

 
In the above example the result, 0F, is MIDI Channel 16.  MIDI channels 00 to 0F 
are called 1 to 16 normally. 
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Set Global Parameter Command 
 
By sending a Set Global Parameter Sys Ex command from a host device, the 
user can change the settings that normally require power-on key combinations.  
In this implementation one parameter byte is changed at a time from the 
parameter list table.  Byte addresses outside of the parameter list range are 
ignored (the CPU may NACK the command attempt).    
 
The command writes a single byte into the CPU, but the new data value is 
transmitted as two bytes.  The first byte is the most significant nibble of the data. 
The second byte is the least significant nibble of the data. 
 
Command: 
 

(hex) F0 System Exclusive  
 7D Manufacturer ID. User settable – default is 7D.  
 23 Device ID for the MTG Pro One CPU.  
 22 Command type (set global parameter).  
 <addr> Parameter # from parameter list table.  
 <msn> Most significant nibble of the new value.   
 <lsn> Least significant nibble of the new value.  
 F7 End of System Exclusive  

 
 
Example: Set the MIDI Clock to 24 = Quarter Note = table hex value 07.  
 

MIDI Clock Rate table excerpt: 

 
 
The parameter number is also 07 for setting the clock rate. 
 

Parameter List table excerpt: 

 
 
 
Transmitted: 

(hex) F0 System Exclusive  
 7D Manufacturer ID. User settable – default is 7D.  
 23 Device ID for the MTG Pro One CPU.  
 22 Command type (set global parameter).  
 07 Parameter # from parameter list table.  
 00 Most significant nibble of the table value 07.   
 07 Least significant nibble of the table value 07.  
 F7 End of System Exclusive  
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Received:  
ACK packet 

 
 
This command switches the arpeggiator and sequencer from LFO/Ext clock 
mode to MIDI clock mode. Make sure the Repeat/Ext switch is in the down (off) 
position. 
 
 
 
 
Get Sequence Data 
 
 
 
The sequence data is stored internally in a very simple format.  Each byte contains a keyboard 
note value (0 to 36) that is played out when a clock-in is received (from either the LFO, an 
external pulse or MIDI).  The TRIG switch information is encoded along with the note number in 
case you use the Sequence Tie Enable mode for extending note values (in normal mode this 
information is ignored).    
 

REST TRIG n n n n n n 
b7 b6 b5 b4 b3 b2 b1 b0 

 
o nnnnnn   – This is the note number information. 
o TRIG   – This is the associated TRIG switch position. 
o REST   – A rest is special byte value 80 (in hex). 

 
End-Of-Sequence is special byte value FF (in hex).  This byte should be included when sending 
sequence data from a PC to the Pro One.   
 
You can actually include key values beyond 36. The encoding above accepts values of 0 to 63 
(decimal).  The DAC in the Pro One is also limited to 6 bits, where each LSB represents a semi-
tone. 
 
 
 
Commands 23 and 25 (hex) read out the data stored in the Pro One’s Sequence 
1 and Sequence 2 banks (respectively).  The data uses the encoding shown 
above, but the data bytes are split into nibble-pairs for transport over MIDI. 
 
Request: 
 

(hex) F0 System Exclusive  
 7D Manufacturer ID. User settable – default is 7D.  
 23 Device ID for the MTG Pro One CPU.  
 23/25 Command type (set global parameter).  
 F7 End of System Exclusive  
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Received: 
(hex) F0 System Exclusive  

 7D Manufacturer ID. User settable – default is 7D.  
 23 Device ID for the MTG Pro One CPU.  
 23/25 Command echo.  
 <   
 : Byte pairs of sequence data.  
 >   
 F7 End of System Exclusive  

 
 
 
Set Sequence Data 
 
Commands 24 and 26 (hex) write new data into the Pro One’s Sequence 1 and 
Sequence 2 banks (respectively).  The data uses the encoding in the previous 
command, but the data bytes are split into nibble-pairs for transport over MIDI.  If 
you use a Get Sequence Data command first you can simply modify the 
Command byte value and it becomes a Set Sequence Data command. 
 
 
Transmitted: 

(hex) F0 System Exclusive  
 7D Manufacturer ID. User settable – default is 7D.  
 23 Device ID for the MTG Pro One CPU.  
 24/26 Command type (write seq1 or write seq2).  
 <   
 : Byte pairs of sequence data.  
 >   
 F7 End of System Exclusive  

 
Received:  

ACK packet 
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